Getting Started

One’s understanding of network protocols can often be greatly deepened by “seeing
protocols in action” and by “playing around with protocols” — observing the sequence of
messages exchanged between two protocol entities, delving down into the details of
protocol operation, and causing protocols to perform certain actions and then observing
these actions and their consequences. This can be done in simulated scenarios or in a
“real” network environment such as the Internet. The Java applets that accompany this
text take the first approach. In these Wireshark labs', we’ll take the latter approach.
You’ll be running various network applications in different scenarios using a computer
on your desk, at home, or in a lab. You’ll observe the network protocols in your computer
“in action,” interacting and exchanging messages with protocol entities executing
elsewhere in the Internet. Thus, you and your computer will be an integral part of these
“live” labs. You’ll observe, and you’ll learn, by doing.

The basic tool for observing the messages exchanged between executing protocol entities
is called a packet sniffer. As the name suggests, a packet sniffer captures (“sniffs”)
messages being sent/received from/by your computer; it will also typically store and/or
display the contents of the various protocol fields in these captured messages. A packet
sniffer itself is passive. It observes messages being sent and received by applications and
protocols running on your computer, but never sends packets itself. Similarly, received
packets are never explicitly addressed to the packet sniffer. Instead, a packet sniffer
receives a copy of packets that are sent/received from/by application and protocols
executing on your machine.

! Earlier versions of these labs used the Ethereal packet analyzer. In May 2006, the developer of Ethereal
joined a new company, and had to leave the Ethereal® trademarks behind. He then created the Wireshark
network protocol analyzer, a successor to Ethereal®. Since Ethereal® is no longer being actively
maintained or developed, we have thus switched these labs over to Wireshark with the 4™ edition of our
text.



Figure 1 shows the structure of a packet sniffer. At the right of Figure 1 are the protocols
(in this case, Internet protocols) and applications (such as a web browser or ftp client)
that normally run on your computer. The packet sniffer, shown within the dashed
rectangle in Figure 1 is an addition to the usual software in your computer, and consists
of two parts. The packet capture library receives a copy of every link-layer frame that
is sent from or received by your computer. Recall from the discussion from section 1.5 in
the text (Figure 1.20%) that messages exchanged by higher layer protocols such as HTTP,
FTP, TCP, UDP, DNS, or IP all are eventually encapsulated in link-layer frames that are
transmitted over physical media such as an Ethernet cable. In Figure 1, the assumed
physical media is an Ethernet, and so all upper layer protocols are eventually
encapsulated within an Ethernet frame. Capturing all link-layer frames thus gives you all
messages sent/received from/by all protocols and applications executing in your
computer.
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Figure 1: Packet sniffer structure

The second component of a packet sniffer is the packet analyzer, which displays the
contents of all fields within a protocol message. In order to do so, the packet analyzer
must “understand” the structure of all messages exchanged by protocols. For example,
suppose we are interested in displaying the various fields in messages exchanged by the
HTTP protocol in Figure 1. The packet analyzer understands the format of Ethernet
frames, and so can identify the IP datagram within an Ethernet frame. It also understands
the IP datagram format, so that it can extract the TCP segment within the IP datagram.
Finally, it understands the TCP segment structure, so it can extract the HTTP message
contained in the TCP segment. Finally, it understands the HTTP protocol and so, for
example, knows that the first bytes of an HTTP message will contain the string “GET,”
“POST,” or “HEAD,” as shown in Figure 2.8 in the text.

2 Figure numbers refer to figures in the 4™ edition of our text.



We will be using the Wireshark packet sniffer [http://www.wireshark.org/] for these labs,
allowing us to display the contents of messages being sent/received from/by protocols at
different levels of the protocol stack. (Technically speaking, Wireshark is a packet
analyzer that uses a packet capture library in your computer). Wireshark is a free network
protocol analyzer that runs on Windows, Linux/Unix, and Mac computers. It’s an ideal
packet analyzer for our labs — it is stable, has a large user base and well-documented
support that includes a user-guide (http://www.wireshark.org/docs/wsug_html_chunked/),
man pages (http://www.wireshark.org/docs/man-pages/), and a detailed FAQ
(http://www.wireshark.org/fag.html), rich functionality that includes the capability to
analyze hundreds of protocols, and a well-designed user interface. It operates in
computers using Ethernet, Token-Ring, FDDI, serial (PPP and SLIP), 802.11 wireless
LANs, and ATM connections (if the OS on which it's running allows Wireshark to do
S0).

Getting Wireshark

In order to run Wireshark, you will need to have access to a computer that supports both
Wireshark and the libpcap or WinPCap packet capture library. The libpcap software will
be installed for you, if it is not installed within your operating system, when you install
Wireshark.. See http://www.wireshark.org/download.html for a list of supported
operating systems and download sites

Download and install the Wireshark software:
e Go to http://www.wireshark.org/download.html and download and install the
Wireshark binary for your computer.
e Download the Wireshark user guide.
The Wireshark FAQ has a number of helpful hints and interesting tidbits of information,
particularly if you have trouble installing or running Wireshark.




Running Wireshark

When you run the Wireshark program, the Wireshark graphical user interface shown in
Figure 2 will de displayed. Initially, no data will be displayed in the various windows.
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Figure 2: Wireshark Graphical User Interface

The Wireshark interface has five major components:

The command menus are standard pulldown menus located at the top of the

window. Of interest to us now are the File and Capture menus. The File menu

allows you

to save captured packet data or open a file containing previously

captured packet data, and exit the Wireshark application. The Capture menu

allows you

to begin packet capture.




e The packet-listing window displays a one-line summary for each packet
captured, including the packet number (assigned by Wireshark; this is not a
packet number contained in any protocol’s header), the time at which the packet
was captured, the packet’s source and destination addresses, the protocol type,
and protocol-specific information contained in the packet. The packet listing can
be sorted according to any of these categories by clicking on a column name. The
protocol type field lists the highest level protocol that sent or received this packet,
i.e., the protocol that is the source or ultimate sink for this packet.

e The packet-header details window provides details about the packet selected
(highlighted) in the packet listing window. (To select a packet in the packet
listing window, place the cursor over the packet’s one-line summary in the packet
listing window and click with the left mouse button.). These details include
information about the Ethernet frame (assuming the packet was sent/receiverd
over an Ethernet interface) and IP datagram that contains this packet. The amount
of Ethernet and IP-layer detail displayed can be expanded or minimized by
clicking on the plus-or-minus boxes to the left of the Ethernet frame or IP
datagram line in the packet details window. If the packet has been carried over
TCP or UDP, TCP or UDP details will also be displayed, which can similarly be
expanded or minimized. Finally, details about the highest level protocol that sent
or received this packet are also provided.

e The packet-contents window displays the entire contents of the captured frame,
in both ASCII and hexadecimal format.

e Towards the top of the Wireshark graphical user interface, is the packet display
filter field, into which a protocol name or other information can be entered in
order to filter the information displayed in the packet-listing window (and hence
the packet-header and packet-contents windows). In the example below, we’ll
use the packet-display filter field to have Wireshark hide (not display) packets
except those that correspond to HTTP messages.

Taking Wireshark for a Test Run

The best way to learn about any new piece of software is to try it out! We’ll assume that
your computer is connected to the Internet via a wired Ethernet interface. Do the
following

1. Start up your favorite web browser, which will display your selected homepage.

2. Start up the Wireshark software. You will initially see a window similar to that
shown in Figure 2, except that no packet data will be displayed in the packet-
listing, packet-header, or packet-contents window, since Wireshark has not yet
begun capturing packets.

3. To begin packet capture, select the Capture pull down menu and select Options.
This will cause the “Wireshark: Capture Options” window to be displayed, as
shown in Figure 3.
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Figure 3: Wireshark Capture Options Window
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4. You can use most of the default values in this window, but uncheck “Hide capture
info dialog” under Display Options. The network interfaces (i.e., the physical
connections) that your computer has to the network will be shown in the Interface
pull down menu at the top of the Capture Options window. In case your computer
has more than one active network interface (e.g., if you have both a wireless and a
wired Ethernet connection), you will need to select an interface that is being used
to send and receive packets (mostly likely the wired interface). After selecting the
network interface (or using the default interface chosen by Wireshark), click Start.
Packet capture will now begin - all packets being sent/received from/by your
computer are now being captured by Wireshark!



5. Once you begin packet capture, a packet capture summary window will appear, as
shown in Figure 4. This window summarizes the number of packets of various
types that are being captured, and (importantly!) contains the Stop button that will
allow you to stop packet capture. Don’t stop packet capture yet.
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Figure 4: Wireshark Packet Capture Window

6. While Wireshark is running, enter the URL:
http://gaia.cs.umass.edu/wireshark-labs/INTRO-wireshark-filel.html
and have that page displayed in your browser. In order to display this page, your
browser will contact the HTTP server at gaia.cs.umass.edu and exchange HTTP
messages with the server in order to download this page, as discussed in section
2.2 of the text. The Ethernet frames containing these HTTP messages will be
captured by Wireshark.

7. After your browser has displayed the INTRO-wireshark-filel.html page, stop
Wireshark packet capture by selecting stop in the Wireshark capture window.
This will cause the Wireshark capture window to disappear and the main
Wireshark window to display all packets captured since you began packet capture.
The main Wireshark window should now look similar to Figure 2. You now have
live packet data that contains all protocol messages exchanged between your
computer and other network entities! The HTTP message exchanges with the
gaia.cs.umass.edu web server should appear somewhere in the listing of packets
captured. But there will be many other types of packets displayed as well (see,
e.g., the many different protocol types shown in the Protocol column in Figure 2).



Even though the only action you took was to download a web page, there were
evidently many other protocols running on your computer that are unseen by the
user. We’ll learn much more about these protocols as we progress through the
text! For now, you should just be aware that there is often much more going on
than “meet’s the eye”!

8. Type in “http” (without the quotes, and in lower case — all protocol names are in
lower case in Wireshark) into the display filter specification window at the top of
the main Wireshark window. Then select Apply (to the right of where you entered
“http”). This will cause only HTTP message to be displayed in the packet-listing
window.

9. Select the first http message shown in the packet-listing window. This should be
the HTTP GET message that was sent from your computer to the
gaia.cs.umass.edu HTTP server. When you select the HTTP GET message, the
Ethernet frame, IP datagram, TCP segment, and HTTP message header
information will be displayed in the packet-header window?®. By clicking plus-
and-minus boxes to the left side of the packet details window, minimize the
amount of Frame, Ethernet, Internet Protocol, and Transmission Control Protocol
information displayed. Maximize the amount information displayed about the
HTTP protocol. Your Wireshark display should now look roughly as shown in
Figure 5. (Note, in particular, the minimized amount of protocol information for
all protocols except HTTP, and the maximized amount of protocol information for
HTTP in the packet-header window).

10. Exit Wireshark

Congratulations! You’ve now completed the first lab.

® Recall that the HTTP GET message that is sent to the gaia.cs.umass.edu web server is contained within a
TCP segment, which is contained (encapsulated) in an IP datagram, which is encapsulated in an Ethernet
frame. If this process of encapsulation isn’t quite clear yet, review section 1.5 in the text
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Figure 5: Wireshark display after step 9



What to hand in

The goal of this first lab was primarily to introduce you to Wireshark. The following
questions will demonstrate that you’ve been able to get Wireshark up and running, and
have explored some of its capabilities. Answer the following questions, based on your
Wireshark experimentation:

1.

2.

List up to 10 different protocols that appear in the protocol column in the
unfiltered packet-listing window in step 7 above.

How long did it take from when the HTTP GET message was sent until the HTTP
OK reply was received? (By default, the value of the Time column in the packet-
listing window is the amount of time, in seconds, since Wireshark tracing began.
To display the Time field in time-of-day format, select the Wireshark View pull
down menu, then select Time Display Format, then select Time-of-day.)

What is the Internet address of the gaia.cs.umass.edu (also known as www-
net.cs.umass.edu)? What is the Internet address of your computer?

Print the two HTTP messages displayed in step 9 above. To do so, select Print
from the Wireshark File command menu, and select “Selected Packet Only’” and
“Print as displayed” and then click OK.



Wireshark Lab: HTTP

Having gotten our feet wet with the Wireshark packet sniffer in the introductory lab,
we’re now ready to use Wireshark to investigate protocols in operation. In this lab, we’ll
explore several aspects of the HTTP protocol: the basic GET/response interaction, HTTP
message formats, retrieving large HTML files, retrieving HTML files with embedded
objects, and HTTP authentication and security. Before beginning these labs, you might
want to review Section 2.2 of the text.

1. The Basic HTTP GET/response interaction

Let’s begin our exploration of HTTP by downloading a very simple HTML file - one that
is very short, and contains no embedded objects. Do the following:

1. Start up your web browser.

2. Start up the Wireshark packet sniffer, as described in the Introductory lab (but
don’t yet begin packet capture). Enter “http” (just the letters, not the quotation
marks) in the display-filter-specification window, so that only captured HTTP
messages will be displayed later in the packet-listing window. (We’re only
interested in the HTTP protocol here, and don’t want to see the clutter of all
captured packets).

3. Wait a bit more than one minute (we’ll see why shortly), and then begin
Wireshark packet capture.

4. Enter the following to your browser
http://gaia.cs.umass.edu/wireshark-labs/HTTP-wireshark-filel.html
Your browser should display the very simple, one-line HTML file.

5. Stop Wireshark packet capture.

Y our Wireshark window should look similar to the window shown in Figure 1. If you
are unable to run Wireshark on a live network connection, you can download a packet
trace that was created when the steps above were followed.'

! Download the zip file http://gaia.cs.umass.edu/wireshark-labs/wireshark-traces.zip and extract the file
http-ethereal-trace-1. The traces in this zip file were collected by Wireshark running on one of the author’s
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Figure 1: Wireshark Display after http://gaia.cs.umass.edu/wireshark-labs/ HTTP-
wireshark-filel.html has been retrieved by your browser

The example in Figure 1 shows in the packet-listing window that two HTTP messages
were captured: the GET message (from your browser to the gaia.cs.umass.edu web
server) and the response message from the server to your browser. The packet-contents
window shows details of the selected message (in this case the HTTP GET message,
which is highlighted in the packet-listing window). Recall that since the HTTP message
was carried inside a TCP segment, which was carried inside an IP datagram, which was
carried within an Ethernet frame, Wireshark displays the Frame, Ethernet, IP, and TCP
packet information as well. We want to minimize the amount of non-HTTP data

computers, while performing the steps indicated in the Wireshark lab. Once you have downloaded the
trace, you can load it into Wireshark and view the trace using the File pull down menu, choosing Open, and
then selecting the http-ethereal-trace-1 trace file. The resulting display should look just like Figure 1.



displayed (we’re interested in HTTP here, and will be investigating these other protocols
is later labs), so make sure the boxes at the far left of the Frame, Ethernet, IP and TCP
information have a plus sign (which means there is hidden, undisplayed information), and
the HTTP line has a minus sign (which means that all information about the HTTP
message is displayed).
(Note: You should ignore any HTTP GET and response for favicon.ico. If you see a reference to
this file, it is your browser automatically asking the server if it (the server) has a small icon file

that should be displayed next to the displayed URL in your browser. We’ll ignore references to
this pesky file in this lab.).

By looking at the information in the HTTP GET and response messages, answer the
following questions. When answering the following questions, you should print out the
GET and response messages (see the introductory Wireshark lab for an explanation of
how to do this) and indicate where in the message you’ve found the information that
answers the following questions.

1. Is your browser running HTTP version 1.0 or 1.1? What version of HTTP is the

server running?

2. What languages (if any) does your browser indicate that it can accept to the
server?
What is the IP address of your computer? Of the gaia.cs.umass.edu server?
What is the status code returned from the server to your browser?
When was the HTML file that you are retrieving last modified at the server?
How many bytes of content are being returned to your browser?
By inspecting the raw data in the packet content window, do you see any headers
within the data that are not displayed in the packet-listing window? If so, name
one.

No ko

In your answer to question 5 above, you might have been surprised to find that the
document you just retrieved was last modified within a minute before you downloaded
the document. That’s because (for this particular file), the gaia.cs.umass.edu server is
setting the file’s last-modified time to be the current time, and is doing so once per
minute. Thus, if you wait a minute between accesses, the file will appear to have been
recently modified, and hence your browser will download a “new” copy of the document.



2. The HTTP CONDITIONAL GET/response interaction

Recall from Section 2.2.6 of the text, that most web browsers perform object caching and
thus perform a conditional GET when retrieving an HTTP object. Before performing the
steps below, make sure your browser’s cache is empty. (To do this under Netscape 7.0,
select Edit->Preferences->Advanced->Cache and clear the memory and disk cache.

For Firefox, select Tools->Clear Private Data, or for Internet Explorer, select Tools-
>|nternet Options->Delete File; these actions will remove cached files from your
browser’s cache.) Now do the following:

Start up your web browser, and make sure your browser’s cache is cleared, as
discussed above.

Start up the Wireshark packet sniffer

Enter the following URL into your browser
http://gaia.cs.umass.edu/wireshark-labs/HTTP-wireshark-file2.html

Your browser should display a very simple five-line HTML file.

Quickly enter the same URL into your browser again (or simply select the refresh
button on your browser)

Stop Wireshark packet capture, and enter “http” in the display-filter-specification
window, so that only captured HTTP messages will be displayed later in the
packet-listing window.

(Note: If you are unable to run Wireshark on a live network connection, you can
use the http-ethereal-trace-2 packet trace to answer the questions below; see
footnote 1. This trace file was gathered while performing the steps above on one
of the author’s computers.)

Answer the following questions:

8.

9.

Inspect the contents of the first HTTP GET request from your browser to the
server. Do you see an “IF-MODIFIED-SINCE” line in the HTTP GET?
Inspect the contents of the server response. Did the server explicitly return the
contents of the file? How can you tell?

10. Now inspect the contents of the second HTTP GET request from your browser to

the server. Do you see an “IF-MODIFIED-SINCE:” line in the HTTP GET? If
so, what information follows the “IF-MODIFIED-SINCE:” header?

11. What is the HTTP status code and phrase returned from the server in response to

this second HTTP GET? Did the server explicitly return the contents of the file?
Explain.



3. Retrieving Long Documents

In our examples thus far, the documents retrieved have been simple and short HTML
files. Let’s next see what happens when we download a long HTML file. Do the
following:

e Start up your web browser, and make sure your browser’s cache is cleared, as
discussed above.

e Start up the Wireshark packet sniffer

e Enter the following URL into your browser
http://gaia.cs.umass.edu/wireshark-labs/HTTP-wireshark-file3.html
Your browser should display the rather lengthy US Bill of Rights.

e Stop Wireshark packet capture, and enter “http” in the display-filter-specification
window, so that only captured HTTP messages will be displayed.

e (Note: If you are unable to run Wireshark on a live network connection, you can
use the http-ethereal-trace-3 packet trace to answer the questions below; see
footnote 1. This trace file was gathered while performing the steps above on one
of the author’s computers.)

In the packet-listing window, you should see your HTTP GET message, followed by a
multiple-packet response to your HTTP GET request. This multiple-packet response
deserves a bit of explanation. Recall from Section 2.2 (see Figure 2.9 in the text) that the
HTTP response message consists of a status line, followed by header lines, followed by a
blank line, followed by the entity body. In the case of our HTTP GET, the entity body in
the response is the entire requested HTML file. In our case here, the HTML file is rather
long, and at 4500 bytes is too large to fit in one TCP packet. The single HTTP response
message is thus broken into several pieces by TCP, with each piece being contained
within a separate TCP segment (see Figure 1.20 in the text). Each TCP segment is
recorded as a separate packet by Wireshark, and the fact that the single HTTP response
was fragmented across multiple TCP packets is indicated by the “Continuation” phrase
displayed by Wireshark. We stress here that there is no “Continuation” message in
HTTP!

Answer the following questions:

12. How many HTTP GET request messages were sent by your browser?

13. How many data-containing TCP segments were needed to carry the single HTTP
response?

14. What is the status code and phrase associated with the response to the HTTP GET
request?

15. Are there any HTTP status lines in the transmitted data associated with a TCP-
induced “Continuation”?



4. HTML Documents with Embedded Objects

Now that we’ve seen how Wireshark displays the captured packet traffic for large HTML
files, we can look at what happens when your browser downloads a file with embedded
objects, i.e., a file that includes other objects (in the example below, image files) that are
stored on another server(s).

Do the following:

e Start up your web browser, and make sure your browser’s cache is cleared, as
discussed above.

e Start up the Wireshark packet sniffer

e Enter the following URL into your browser
http://gaia.cs.umass.edu/wireshark-labs/HTTP-wireshark-file4.html
Your browser should display a short HTML file with two images. These two
images are referenced in the base HTML file. That is, the images themselves are
not contained in the HTML; instead the URLS for the images are contained in the
downloaded HTML file. As discussed in the textbook, your browser will have to
retrieve these logos from the indicated web sites. Our publisher’s logo is
retrieved from the www.aw-bc.com web site. The image of our book’s cover is
stored at the manic.cs.umass.edu server.

e Stop Wireshark packet capture, and enter “http” in the display-filter-specification
window, so that only captured HTTP messages will be displayed.

e (Note: If you are unable to run Wireshark on a live network connection, you can
use the http-ethereal-trace-4 packet trace to answer the questions below; see
footnote 1. This trace file was gathered while performing the steps above on one
of the author’s computers.)

Answer the following questions:
16. How many HTTP GET request messages were sent by your browser? To which
Internet addresses were these GET requests sent?
17. Can you tell whether your browser downloaded the two images serially, or
whether they were downloaded from the two web sites in parallel? Explain.

5 HTTP Authentication

Finally, let’s try visiting a web site that is password-protected and examine the sequence
of HTTP message exchanged for such a site. The URL
http://gaia.cs.umass.edu/wireshark-labs/protected_pages/HT TP-wireshark-file5.html is
password protected. The username is “wireshark-students” (without the quotes), and the
password is “network” (again, without the quotes). So let’s access this “secure”
password-protected site. Do the following:

e Make sure your browser’s cache is cleared, as discussed above, and close down

your browser. Then, start up your browser
e Start up the Wireshark packet sniffer



e Enter the following URL into your browser
http://gaia.cs.umass.edu/wireshark-labs/protected_pages/HTTP-wireshark-
file5.html
Type the requested user name and password into the pop up box.

e Stop Wireshark packet capture, and enter “http” in the display-filter-specification
window, so that only captured HTTP messages will be displayed later in the
packet-listing window.

e (Note: If you are unable to run Wireshark on a live network connection, you can
use the http-ethereal-trace-5 packet trace to answer the questions below; see
footnote 1. This trace file was gathered while performing the steps above on one
of the author’s computers.)

Now let’s examine the Wireshark output. You might want to first read up on HTTP
authentication by reviewing the easy-to-read material on “HTTP Access Authentication
Framework™ at http://frontier.userland.com/stories/storyReader$2159

Answer the following questions:
18. What is the server’s response (status code and phrase) in response to the initial
HTTP GET message from your browser?
19. When your browser’s sends the HTTP GET message for the second time, what
new field is included in the HTTP GET message?

The username (wirehsark-students) and password (network) that you entered are encoded
in the string of characters (d2lyZXNoY XJrLXNOdWRIbnRzOm51dHdvems=) following
the “Authorization: Basic” header in the client’s HTTP GET message. While it
may appear that your username and password are encrypted, they are simply encoded in a
format known as Base64 format. The username and password are not encrypted! To see
this, go to http://www.securitystats.com/tools/base64.php and enter the base64-encoded
string d2lyZXNoY XJrLXNOdWRIbnRz and press decode. Voila! You have translated
from Base64 encoding to ASCII encoding, and thus should see your username! To view
the password, enter the remainder of the string Om5ldHdvems= and press decode. Since
anyone can download a tool like Wireshark and sniff packets (not just their own) passing
by their network adaptor, and anyone can translate from Base64 to ASCII (you just did
it!), it should be clear to you that simple passwords on WWW sites are not secure unless
additional measures are taken.

There are ways to make WWW access more secure.
However, we’ll clearly need something that goes beyond the basic HTTP authentication
framework!



DNS

As described in Section 2.5 of the textbook, the Domain Name System (DNS) translates
hostnames to IP addresses, fulfilling a critical role in the Internet infrastructure. In this
lab, we’ll take a closer look at the client side of DNS. Recall that the client’s role in the
DNS is relatively simple — a client sends a query to its local DNS server, and receives a
response back. As shown in Figures 2.21 and 2.22 in the textbook, much can go on
“under the covers,” invisible to the DNS clients, as the hierarchical DNS servers
communicate with each other to either recursively or iteratively resolve the client’s DNS
query. From the DNS client’s standpoint, however, the protocol is quite simple — a query
is formulated to the local DNS server and a response is received from that server.

Before beginning this lab, you’ll probably want to review DNS by reading Section 2.5 of
the text. In particular, you may want to review the material on local DNS servers, DNS
caching, DNS records and messages, and the TYPE field in the DNS record.

1. nslookup

In this lab, we’ll make extensive use of the nslookup tool, which is available in most
Linux/Unix and Microsoft platforms today. To run nslookup in Linux/Unix, you just type
the nslookup command on the command line. To run it in Windows, open the Command
Prompt and run nslookup on the command line.

In it is most basic operation, nslookup tool allows the host running the tool to query any
specified DNS server for a DNS record. The queried DNS server can be a root DNS
server, a top-level-domain DNS server, an authoritative DNS server, or an intermediate
DNS server (see the textbook for definitions of these terms). To accomplish this task,
nslookup sends a DNS query to the specified DNS server, receives a DNS reply from that
same DNS server, and displays the result.



&+ | Command Prompt

C:=~2>nzlookup www._mit.edu
Server: dns—prime.poly.edu
Address: 128.238.29.22

uwy .mit _edu
18.7.22_83

C=~2>nslookup —tgpe=NS mit.edu

Server: dns—prime.poly.edu
Address: 128.238.29.22

Mon—authoritative answer:

mit.edu nameserver bitsy.mit.edu
mit.edu nameserver stravb.mit.edu
mit.edu nameserver w2Bns .mit .edu

hitsy.mit.edu internet address 18.72.8.3
strawbh.mit.edu internet address 18.71.8.151
w2Bns .mit .edu internet address 18.78.8.1608

C:~nzlookup vww._aiit.or. kr bhitsy.mit.edu
BITSY .MIT .EDU
18.72.8.3

Mon—authoritative answer:
Mame = www.aiit.or. ke
Addre=zs: 218_36.94_.20608

SR

The above screenshot shows the results of three independent nslookup commands
(displayed in the Windows Command Prompt). In this example, the client host is located
on the campus of Polytechnic University in Brooklyn, where the default local DNS server
is dns-prime.poly.edu. When running nslookup, if no DNS server is specified, then
nslookup sends the query to the default DNS server, which in this case is dns-
prime.poly.edu. Consider the first command:

nslookup www.mit.edu

In words, this command is saying “Please send me the IP address for the host
www.mit.edu.” As shown in the screenshot, the response from this command provides
two pieces of information: (1) the name and IP address of the DNS server that provides
the answer; and (2) the answer itself, which is the host name and IP address of
www.mit.edu. Although the response came from the local DNS server at Polytechnic
University, it is quite possible that this local DNS server iteratively contacted several
other DNS servers to get the answer, as described in Section 2.5 of the textbook.

Now consider the second command:

nslookup —type=NS mit.edu

In this example, we have provided the option “-type=NS” and the domain “mit.edu”. This
causes nslookup to send a query for a type-NS record to the default local DNS server. In

words, the query is saying, “Please send me the host names of the authoritative DNS for
mit.edu.” (When the —type option is not used, nslookup uses the default, which is to query



for type A records; see Section 2.5.3 in the text.) The answer, displayed in the above
screenshot, first indicates the DNS server that is providing the answer (which is the
default local DNS server) along with three MIT name servers. Each of these servers is
indeed an authoritative DNS server for the hosts on the MIT campus. However, nslookup
also indicates that the answer is “non-authoritative,” meaning that this answer came from
the cache of some server rather than from an authoritative MIT DNS server. Finally, the
answer also includes the IP addresses of the authoritative DNS servers at MIT. (Even
though the type-NS query generated by nslookup did not explicitly ask for the IP
addresses, the local DNS server returned these “for free” and nslookup displays the
result.)

Now finally consider the third command:

nslookup www.aiit.or.kr bitsy.mit.edu

In this example, we indicate that we want to the query sent to the DNS server
bitsy.mit.edu rather than to the default DNS server (dns-prime.poly.edu). Thus, the query
and reply transaction takes place directly between our querying host and bitsy.mit.edu. In
this example, the DNS server bitsy.mit.edu provides the IP address of the host
wwwe.aiit.or.kr, which is a web server at the Advanced Institute of Information
Technology (in Korea).

Now that we have gone through a few illustrative examples, you are perhaps wondering
about the general syntax of nslookup commands. The syntax is:

nslookup —optionl —option2 host-to-find dns-server

In general, nslookup can be run with zero, one, two or more options. And as we have seen
in the above examples, the dns-server is optional as well; if it is not supplied, the query is
sent to the default local DNS server.

Now that we have provided an overview of nslookup, it is time for you to test drive it
yourself. Do the following (and write down the results):

1. Run nslookup to obtain the IP address of a Web server in Asia.

2. Run nslookup to determine the authoritative DNS servers for a university in
Europe.

3. Run nslookup so that one of the DNS servers obtained in Question 2 is queried for
the mail servers for Yahoo! mail.

2. ipconfig

ipconfig (for Windows) and ifconfig (for Linux/Unix) are among the most useful little
utilities in your host, especially for debugging network issues. Here we’ll only describe
ipconfig, although the Linux/Unix ifconfig is very similar. ipconfig can be used to show
your current TCP/IP information, including your address, DNS server addresses, adapter



type and so on. For example, if you want to see all this information about your host,
simply enter:

ipconfig \all

into the Command Prompt, as shown in the following screenshot.

=+ | Command Prompt
C:~>ipconfig ~all

Windows IP Configuration

Host Mame
Primary Dns Suffix
Mode Tuype
IP Routing Enabled
WINS Proxy Enabled

Ethernet adapter Local Area Connection:

Connection—specific DNS Suffix . : poly.edu
Description : Intel<R> PRO-18@ UE HNetwork Connecti

Physical Address. . - - - . . . . = BO-A?-6B-18-60-99
Dhcp Enabled H
Autoconfiguration Enahled H
IP Address. - . . . -« o« o« « = = = = .238.38.168
Zubnet Mask H .255.255.8
Default Gateway H .238.38.1
DHCP Server H .238.29 .25
DHE Servers H .238.29.22
.238.29.23
.238.2.38
.238.32.22
Primary WIMNS Server H .238.29.23
Secondary WINS Server H .238 .29 .22
Lease Obtained H August 38, 2PA4 1:30:58 PM
Lease Expires . . . . . . . . . . & Monday, fAugust 38, 20084 7:3@:50 PH

ipconfig is also very useful for managing the DNS information stored in your host. In
Section 2.5 we learned that a host can cache DNS records it recently obtained. To see
these cached records, after the prompt C:\> provide the following command:

ipconfig /displaydns

Each entry shows the remaining Time to Live (TTL) in seconds. To clear the cache, enter

ipconfig /flushdns

Flushing the DNS cache clears all entries and reloads the entries from the hosts file.



3. Tracing DNS with Wireshark

Now that we are familiar with nslookup and ipconfig, we’re ready to get down to some
serious business. Let’s first capture the DNS packets that are generated by ordinary Web-
surfing activity.

e Use ipconfig to empty the DNS cache in your host.

e Open your browser and empty your browser cache. (With Internet Explorer,
go to Tools menu and select Internet Options; then in the General tab select
Delete Files.)

e Open Wireshark and enter “ip.addr == your_IP_address” into the filter, where
you obtain your_IP_address (the IP address for the computer on which you are
running Wireshark) with ipconfig. This filter removes all packets that neither
originate nor are destined to your host.

e Start packet capture in Wireshark.

e With your browser, visit the Web page: http://www.ietf.org

e Stop packet capture.

If you are unable to run Wireshark on a live network connection, you can download a
packet trace file that was captured while following the steps above on one of the author’s
computers®. Answer the following questions:

4.
5.

6.

10.

Locate the DNS query and response messages. Are they sent over UDP or TCP?
What is the destination port for the DNS query message? What is the source port
of DNS response message?

To what IP address is the DNS query message sent? Use ipconfig to determine the
IP address of your local DNS server. Are these two IP addresses the same?
Examine the DNS query message. What “Type” of DNS query is it? Does the
query message contain any “answers”?

Examine the DNS response message. How many “answers” are provided? What
does each of these answers contain?

Consider the subsequent TCP SYN packet sent by your host. Does the destination
IP address of the SYN packet correspond to any of the IP addresses provided in
the DNS response message?

This web page contains images. Before retrieving each image, does your host
issue new DNS queries?

! Download the zip file http://gaia.cs.umass.edu/wireshark-labs/wireshark-traces.zipand extract the file dns-
ethereal-trace-1. The traces in this zip file were collected by Wireshark running on one of the author’s
computers, while performing the steps indicated in the Wireshark lab. Once you have downloaded the
trace, you can load it into Wireshark and view the trace using the File pull down menu, choosing Open, and
then selecting the dns-ethereal-trace-1 trace file.




Now let’s play with nslookup?.

e Start packet capture.
e Do an nslookup on www.mit.edu
e Stop packet capture.

You should get a trace that looks something like the following:
i1l {Untitled) - Wireshark P[]
File Edit Wew Go Capture @nalvee Statistics  Help

B e @ 2 @ *x &« 8| @ « 2 » F & | HE &« a q O
Filker: |ip.addr==192.168.2.145 ¥  Expression... Clear Apply
Mo, - |Time |Source |Destination |Protoco| |InF0 =
1 0.000000 1%2.168.2.145 192.168.1.1 DNS standard guery PTR 1.1.168.19%2,in-addr.ar
2 0.004228 192.168.1.1 192.168.2.145 DS standard guery response PTR dslrouter
3 0.013858 192.168.2.145 192.168.1.1 DNS standard guery A www.mit.edu.myhome.weste
4 0.074954 192.168.1.1 192,168, 2.145 DNS standard guery response
50, Osd 55 102, Tasd. 2. 145 152, Tes.1.] Standard <A wwwL M. adul
6 0.1406833 152.168.1.1 152,168, 2.145 DNS standard guery response A 18.7.22.83 4
2| | |
® Destination: LinksysG_45:90:a8 (00:0c:41:45:90:a8) el

# Source: Metgear_6l:8e:6d (00:09:5h:61:8e:6d)
Type: IP (Ox0800)
# Internet Protocol, Src: 192.168.2.145 (192.168.2.145), Dst: 192.168.1.1 (192.168.1.1)
[+ User Datagram Protocol, Src Port: 1565 (1365), Dst Port: domain (53)
= Domain Mame System (guery)
Response In: &
Transaction ID: 0x0003
B Flags: 0x0100 (standard query)
questions: 1
Answer RRs: 0O
Authority RRs: 0
additional rRrs: 0O
= queries
Bl www.mit.edu: type 4, class IN
Mame: www.mit.edu
Type: A (Host address)
Class: IN (0Ox0001)
| | 2l
0000 00 OC 41 45 S0 a8 00 0% 5h 61 8e &d 08 00 45 00
0010 00 39 73 28 00 00 B0 11 42 a% <0 aB 02 91 <0 aB
0020 01 01 06 1d 00 35 00 25 21 ¢l 00 03 01l 00 00 01

QO30 00 Q0 00 00 Q0 00 03 FF VY YV 03 ad 6% V4 03 &3
0040 &4 75 00 00 01 00 01

Ll

sl |

File: "C\DOCUME 1\PALILAW ~ 1 \LOCALS-1  Templether ka0l 796" 713 Bytes 00:00:( | P: 6 D: 6 M: 0Drops: O

We see from the above screenshot that nslookup actually sent three DNS queries and
received three DNS responses. For the purpose of this assignment, in answering the
following questions, ignore the first two sets of queries/responses, as they are specific to
nslookup and are not normally generated by standard Internet applications. You should
instead focus on the last query and response messages.

2 If you are unable to run Wireshark and capture a trace file, use the trace file dns-ethereal-trace-2 in the
zip file http://gaia.cs.umass.edu/wireshark-labs/wireshark-traces.zip




11. What is the destination port for the DNS query message? What is the source port
of DNS response message?

12. To what IP address is the DNS query message sent? Is this the IP address of your
default local DNS server?

13. Examine the DNS query message. What “Type” of DNS query is it? Does the
query message contain any “answers”?

14. Examine the DNS response message. How many “answers” are provided? What
does each of these answers contain?

15. Provide a screenshot.

Now repeat the previous experiment, but instead issue the command:

nslookup —type=NS mit.edu
Answer the following questions® :

16. To what IP address is the DNS query message sent? Is this the IP address of your
default local DNS server?

17. Examine the DNS query message. What “Type” of DNS query is it? Does the
query message contain any “answers”?

18. Examine the DNS response message. What MIT name servers does the response
message provide? Does this response message also provide the IP addresses of the
MIT name servers?

19. Provide a screenshot.

Now repeat the previous experiment, but instead issue the command:
nslookup www.aiit.or.kr bitsy.mit.edu
Answer the following questions®:

20. To what IP address is the DNS query message sent? Is this the IP address of your
default local DNS server? If not, what does the IP address correspond to?

21. Examine the DNS query message. What “Type” of DNS query is it? Does the
query message contain any “answers”?

22. Examine the DNS response message. How many “answers” are provided? What
does each of these answers contain?

23. Provide a screenshot.

% If you are unable to run Wireshark and capture a trace file, use the trace file dns-ethereal-trace-3 in the
zip file http://gaia.cs.umass.edu/wireshark-labs/wireshark-traces.zip
* If you are unable to run Wireshark and capture a trace file, use the trace file dns-ethereal-trace-4 in the
zip file http://gaia.cs.umass.edu/wireshark-labs/wireshark-traces.zip




